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Getting started
The BlackBerry® AtHoc® management system uses the IIM add-on module interface with Giant Voice (GV)
outdoor warning devices to enable wide-area Mass Notification System (MNS) broadcasts. Giant Voice features
can broadcast critical information using voice messages, wave files, musical tones, or text-to-speech (TTS)
conversion. Federal Signal GV supports outdoor Public Address (PA) systems that have large amplified speakers.
Typically, speakers are set on poles in an array that covers a specified area with enough acoustic sound to
override the ambient noise with emergency notification.

After the BlackBerry AtHoc management system is integrated with a Federal Signal Giant Voice System, operators
can disseminate emergency alerts to the siren system from the BlackBerry AtHoc management console. Alert
messages can be delivered using Key functions programmed in the Federal Signal hardware or software,
text-to-speech or pre-recorded audio files to dynamically selected targets. Targeting choices are All Poles
simultaneously, individual Zones of poles, and Poles.
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Product requirements
The following sections describe the hardware and software requirements to install and configure the Federal
Signal Giant Voice system.

Hardware requirements
• Federal Signal SS2000D with 7.1.5.8 firmware; OR,
• Federal Signal SS2000+ with 1.8.1.30 firmware; OR,
• Federal Signal Commander® Digital System Software with BlackBerry AtHoc plug-in

Software requirements
• BlackBerry AtHoc release 6.1.8.63 or newer
• IP Integration Module capnode_obf.jar 8/19/2009 or newer

You must also update the following files that are not specific to Federal Signal Giant Voice systems:

• IIM Management (Agent) Configuration
• C:\Program Files\capnode\AlertTemplate\SirenCentralStatusTemplate.xml
• C:\Program Files\capnode\myid.property
• C:\Program Files\capnode\title.property
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Specific usage data collection
Configuration of a Federal Signal integration requires attention to detail as there are many components to be
configured and data to be collected. Connection with the Federal Signal SS2000D, SS2000+ encoder, or the
Commander® Digital System software is made through an RS-232 serial cable, analog audio connection, and relay
switching logic.

In addition to the basic Public Address functions that allow the playing of pre-recorded audio or text-to-speech
audio over the Federal Signal Giant Voice system, the BlackBerry AtHoc Federal Signal device allows mapping
of pre-recorded audio messages and tones stored at the poles themselves. These Key functions allow for the
highest audio clarity available through the system and should be configured as a priority.

Public Address activations allow dynamic targeting of poles, zones, or all poles simultaneously. In most cases,
emergency broadcasts target all poles simultaneously. If more granular targeting is desired, a list of poles,
location names, pole/zone grouping, and zone location names should be collected.

Key activations use the pole/zone/all targeting that is configured in the SS2000D, SS2000+ encoder, or the
Commander® software Hot Keys.

When an alert is received by the IIM:

• The IIM sends an actuation serial command to the SS2000D, SS2000+, or Commander® PC and pauses.
• The Federal Signal encoder transmits the actuation data with the selected target to the poles.
• If the intended content was PA, the IIM plays the selected audio content.
• The IIM sends a cancel all serial command to the SS2000D, SS2000+, or Commander® PC and pauses.
• The Federal Signal encoder transmits the cancel all data to the poles.
• If additional targets are specified, the cycle repeats the sequence with the next specified target and content.

For detailed information about how to configure and program SS2000D, refer to the SS2000D Controller/Encoder
Installation and Operation Instructions, (Federal Signal Corporation, Document #255318G1). The SS2000D should
only be configured by a factory authorized service representative.

For detailed information about how to configure and program SS2000+, refer to the Federal Signal Safety and
Security Systems / Alert & Notification SS2000+ Manual, (Federal Signal Corporation, Document #255400C). The
SS2000+ should only be configured by a factory authorized service representative.

Federal Signal Commander® Digital System software should only be configured by a factory authorized service
representative.

Federal Signal Giant Voice poles are programmed with Remote Terminal Unit (RTU) functions. A table of these
functions needs to be collected to record which RTU function number contains the Public Address function. This
information can be found by reading out the SS2000D, SS2000+, or observing the “Activation” table within the
Commander® software.

The Federal Signal SS2000D or SS2000+ encoders are programmed with Hot Key functions. The SS2000D has
18 physical push buttons and 2 additional internal functions. The SS2000+ has 24 physical push buttons and 36
additional internal functions. The Commander® software has the ability to configure up to 60 activation functions.

In most cases when a site currently has an SS2000D encoder, the encoder needs to be replaced with an
SS2000+ encoder to facilitate continuation of legacy functionality while adding the BlackBerry AtHoc integrated
functionality. Primarily this is because an SS2000D encoder only has one serial port so any single SS2000D unit
can only be connected to either the Federal Signal Commander® PC or to the BlackBerry AtHoc IIM.

Earlier installations used two SS2000D units, wired in parallel, such that one was connected to the Federal Signal
Commander® PC and the other connected to the BlackBerry AtHoc IIM. The programming of both units was
identical except that the SS2000D connected to the BlackBerry AtHoc IIM would have the 7.1.5.8 version firmware
and all button programming would be configured to use the Auto Send mode. The legacy-use SS2000D typically
has buttons programmed with the Auto Prompt Send mode requiring an operator to make the button selection
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and then press the Send button. When an SS2000D is configured for manual operator use, the user needs to turn
the key switch to unlock the unit, push an activation button, and then press the send button. On failing to follow
the sequence, they can press the clear button to back out, press the intended button, and then press send.

The BlackBerry AtHoc functionality uses the Auto Send mode so that pressing the Send button is not required. On
pressing the activation button, Auto Send mode sends the command instantly. While in Auto Prompt Send mode,
the Send button is pressed after the activation button, before it sends the command. Integrated functions require
Auto Send mode, but when the desktop encoder is to be used manually the buttons should be programmed as
Auto Prompt Send, so accidents can be avoided.

Earlier the Federal Signal SSLoader software was used to:

• Read the configuration from the legacy SS2000D
• Flash the firmware in the BlackBerry AtHoc-integrated SS2000D
• Modify the button configuration section from the legacy SS2000D, converting from “Auto Prompt Send” to

“Auto Send”
• Write the configuration file to the BlackBerry AtHoc-integrated SS2000D

Additionally, any unused buttons can be used to expand the functionality of the Legacy SS2000D and the
BlackBerry AtHoc Key functions through the BlackBerry AtHoc-integrated SS2000D.

The newer SS2000+ encoder has two serial ports and both the Federal Signal Commander® PC and the
BlackBerry AtHoc IIM can be connected concurrently. In these cases, the SS2000+ needs to be flashed using the
SSLoader+ software with the 1.8.1.30 version firmware to allow connection to COM2.

The first 24 button Activation functions are programmed for Legacy operator use in Auto Prompt Send mode.
Activation Functions 25 to 48 can be copied from the first 24 buttons but configured for Auto Send mode.
Functions 49 to 60 can contain user desired functions that are available in the RTU function list but not
programmed into the buttons. If there are unconfigured buttons, functions programmed into 25 to 60 can be
condensed. Additionally, the Public Address Activation Function does not need to be copied into the higher range
as the BlackBerry AtHoc integration targets the Public Address function directly through the RTU Function.

If an IP network is used to communicate directly between the Commander® software and RTUs instead
of SS2000D or SS2000+ encoders, the IIM serial and audio functions are connected to the Federal Signal
Commander® PC or server. The BlackBerry AtHoc alert Keys are mapped to the Commander® software Activation
Hot Keys.

Irrespective of which integration method is used, the Key data that needs to be collected, is a list of the Activation
Function or Hot Key numbers and functions.

If the site plays audio files not currently stored at the poles or in the BlackBerry AtHoc audio library, additional
WAV files can be provided by the site to add them to the library. These WAV files should be converted to mono,
compressed down to 8 or 16-bit sampling, and have all frequencies below 400 Hz removed before uploading,
although WAV Windows PCM, 8 KHz to 48 KHz, 8-bit or 16-bit, mono or stereo files will work.

Note:  Audio files should be carefully edited to remove frequencies below 400 Hz. Sustained low frequencies can
cause damage to certain vendors’ electronic components.

For best results, any WAV file intended to be played by the IIM should be tested and verified prior to use in a live
alerting situation.

If the WAV file is greater than 2 MB in size, the Audio File Uploader tool, found in the Studio tab may indicate an
error. Please contact BlackBerry AtHoc support for additional instructions on how to upload oversized files.

If the GV system uses radio frequency (RF) communications between the Central Control Unit (CCU) and RTUs,
check the associated radio Push-To-Talk Time-Out-Timer setting. This setting should be at set to 5 minutes or
“infinite” to ensure that audio transmissions do not get cut off. Check with the site’s GV System Maintenance or
RF System Maintenance POC to ensure that this setting is correct.
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Configure the Federal Signal device
Configure the Federal Signal gateway in the Settings section of the BlackBerry AtHoc management system to
enable the BlackBerry AtHoc alerts system to publish alerts through Federal Signal.

Configure the Federal Signal device on the BlackBerry AtHoc
application server
Log in to the BlackBerry AtHoc management system and check the Delivery Gateways section to verify that the
Federal Signal and XML Feed device gateways have been installed. If they are installed, skip this section.

1. Log in to the BlackBerry AtHoc application server as an administrator.
2. Navigate to the following folder: <IWSAlerts Install Path>\ServerObjects\Tools and run the

AtHoc.Applications.Tools.InstallPackage.exe file.
3. On the Configure Device Support screen, select Federal Signal Giant Voice and Xml Feed.
4. Click Enable.
5. When the Installation Complete pop-up window is displayed, click OK.
6. Click Close.

Configure the delivery gateway
1. Log in to the BlackBerry AtHoc management system as an administrator.
2. In the navigation bar, click .
3. In the Devices section, click Federal Signal Giant Voice.
4. On the Federal Signal Giant Voice  page, click Copy default settings.
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5. Click Save.
6. In the navigation bar, click .
7. In the Devices section, click Xml Feed.
8. Click Copy default settings.
9. In the Feed Source section, select Delivery Gateway ID.
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10.Click Save.

Enable the Federal Signal Giant Voice device
1. In the navigation bar, click .
2. In the Devices section, click Devices.
3. On the Devices page, click the Mass Devices tab.
4. Click Federal Signal Giant Voice.
5. On the Federal Signal Giant Voice page, click Edit.
6. In the Delivery Gateways section, click Add a Delivery Gateway > Federal Signal Giant Voice.
7. In the Federal Signal Giant Voice row, click .

8. On the Configure Gateway window, check for XML code in the Configuration XML field. If the field is empty,
copy and paste the following code into the field:

<Configuration>
<CapParams>
    <GVSystemType>FederalSignal</GVSystemType>
    <AllMode>0</AllMode>
    <ZoneMode>1</ZoneMode>
    <PoleMode>2</PoleMode>
    <KeyMode>4</KeyMode>
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    <UnusedMode>0</UnusedMode>
    <DefaultAllCall>0</DefaultAllCall>
    <DefaultKeyActivationCode>0</DefaultKeyActivationCode>
    <NoPARequired>0</NoPARequired>
    <PARequired>1</PARequired>
    <IsCancelable>false</IsCancelable>
    <ContentSource>GiantVoice</ContentSource>
</CapParams>
</Configuration>

9. Click Submit.
10.Click Save.
11.Click More Actions > Enable.

Enable the Xml Feed device
1. In the navigation bar, click .
2. In the Devices section, click Devices.
3. On the Devices page, click the Mass Devices tab.
4. Click Xml Feed.
5. On the Xml Feed page, click Edit.
6. In the Delivery Gateways section, click Add a Delivery Gateway > Xml Feed.
7. In the Xml Feed row, click .

8. On the Configure Gateways window, check for XML code in the Configuration XML field. If the XML
statements are not provided, copy and paste the following code into the field:

<Configuration>
<DeviceType>FEED</DeviceType>
</Configuration> 

9. Click Submit.
10.Click Save.
11.Click More Actions > Enable.

Set up mass device endpoints (targets)
To create a speaker pole, zone, or an all-poles user, an operator should perform the normal Mass Device Endpoint
creation flow. You should give the endpoint a functionally descriptive name, so that it is recognizable in End User
Manager and Report windows as a mass-communication device target entity.
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Create mass device zone and pole endpoints
To create a new mass device endpoint for each zone and pole, complete the following steps:

1. Log in to BlackBerry AtHoc management system as an administrator.
2. In the navigation bar, click  .
3. In the Devices section, click Mass Devices Endpoints.
4. Click New.
5. Select Federal Signal Giant Voice from the list.
6. To create a new endpoint for an All Poles zone, complete the following:

a. In the General section, for the Display Name field, enter a name that describes the function of the
associated call key, so that it is easy to identify which key is for which function.

b. In the Configuration section, select the Zone option for Giant Voice type.
c. In Address field, enter “A,x” into the Address field, where “x” is the RTU Function number of the Public

Address function (in this case RTU function 6).
7. To create a new endpoint for a preconfigured zone, complete the following steps:

a. In the General section, for the Display Name field, enter a name that describes the function of the
associated call key, so that it is easy to identify which key is for which function.

b. In the Configuration section, select the Zone option for Giant Voice type.
c. In the Address field, enter “Z,x,y”, where “x” is the zone number and “y” is the RTU Function number of the

Public Address function (in this case, zone 1 and RTU Function 6).
8. To create a new endpoint for a pole, complete the following steps:

a. In the General section, for the Display Name field, enter a name that describes the function of the
associated call key, so that it is easy to identify which key is for which function.

b. In the Configuration section, select the Pole option for Giant Voice type.
c. In the Address field, enter "P,x,y”, where “x” is the zone number and “y” is the RTU Function number of the

Public Address function (in this case, pole 1 and RTU Function 6).
9. Click Save.

Create a mass device key endpoint
To create the object that displays the list of keys associated with SS2000D Function Keys, SS2000+ Activation
Functions, or Commander Activation Hot keys, complete the following tasks:

• Create the ATHOC-GV-KEYS attribute XML configuration.
• Perform the normal Mass Device Endpoint creation flow.

Create the Key XML configuration

For integrations with Federal Signal SS2000D encoders

This section describes how to program the SS2000D to integrate with the BlackBerry AtHoc IIM and create the
Key User ATHOC-GV-KEYS attribute configuration.

1. Follow the instructions in the Federal Signal Corporation SS2000D Controller/Encoder Installation and Operation
Instructions, Document #255318G1 regarding the use of the Federal Signal SS2000 loader software and read
the .DAT file from the SS2000D and then save it to a local drive.

2. Edit the Mode field of each Function Key to change from Mode 3 = Auto Send to Mode 2 = Auto Prompt
Send and save the .DAT file with BlackBerry AtHoc in the name to differentiate it from the previously
saved .DAT file.
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3. Program the 7.1.5.8.BIN firmware version and the BlackBerry AtHoc.DAT file with SS2000D to integrate
with the BlackBerry AtHoc IIM.

4. Copy the content below into a Notepad and modify it to match the Function Keys. The XML maps to the
Function Key screen as shown in the following example:

The following table provides the definition for each attribute.
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Attribute Name Description

Id Corresponds to the address of the key within the Giant Voice system.
This addressing scheme varies by Giant Voice vendor.

messgaeIdRef References the <message> object to be displayed as a warning in the
Targeting screen in the Management System during the publishing cycle.

targetingRule Used to establish correct targeting behavior for the key. Possible values
are:

• TargetingNotAllowed
• TargetingAllowed
• TargetingRequired

name The name of the Giant Voice key that is displayed in the publishing flow.

description The description of the Giant Voice key that is displayed in the publishing
flow. If there are more than 5 keys, this will not be displayed.

Note:  Key number 2, Public Address, is skipped as Public Address functions are handled as an RTU Function
through the All Poles, Pole, and Zone target user device address instead of a Function Key.

Note:  For Federal Signal Giant Voice Keys, the messageIdRef parameter is always MSG-TARGETING-NOT-
ALLOWED and the targetingRule parameter is always TargetingNotAllowed. This is because the targeting
is set in the SS2000D Function Keys and cannot be overridden.

Note:  The key name and description parameters cannot contain space or any of the following characters:  ' !
$ % ^ ( ) = { } , ; : ? " < > |

<giantVoiceSetting> 
<messages> 
    <message id = "MSG-TARGETING-NOT-ALLOWED">The Giant Voice Key you have
 selected on the previous page does not allow
additional selection of Giant Voice poles or zones.  You may still target users
 for other devices, but Giant Voice targeting
will be ignored.</message> 
    <message id = "MSG-TARGETING-ALLOWED">The Giant Voice Key you have selected on
 the previous page already has Giant
Voice poles and zones targeted, but you can override them by targeting different
 zones in the Targeting area just below.</message> 
    <message id = "MSG-TARGETING-REQUIRED">The Giant Voice Key you have selected
 on the previous page does not have any
targeting information built-in, and will require you to target at least one Giant
 Voice pole or zone below.</message> 
</messages> 
<keys>
    <key 
        id = "1" 
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED" 
        targetingRule = "TargetingNotAllowed"> 
        <name>Attack Warn</name> 
        <description>Attack Warn</description> 
    </key>
    <key 
        id = "3"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
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        targetingRule = "TargetingNotAllowed">
        <name>Disaster Warn</name>
        <description>Disaster Warn</description>
    </key>
    <key 
        id = "4"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Tornado Warn</name>
        <description>Tornado Warn</description>
    </key>
    <key 
        id = "5"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>T-Storm Warn</name>
        <description>T-Storm Warn</description>
    </key>
    <key 
        id = "6"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Flash Flood Warn</name>
        <description>Flash Flood Warn</description>
    </key>
    <key 
        id = "7"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Shelter In Place</name>
        <description>Shelter In Place</description>
    </key>
    <key 
        id = "8"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>All Clear Msg</name>
        <description>All Clear Msg</description>
    </key>
    <key 
        id = "9"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Exercise Msg</name>
        <description>Exercise Msg</description>
        </key>        
    <key 
        id = "10"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Alt Steady</name>
        <description>Alt Steady</description>
    </key>
    <key 
        id = "11"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Test Message</name>
        <description>Test Message</description>
    </key>
    <key 
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        id = "12"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Chimes</name>
        <description>Westminster Chimes</description>
    </key>
    <key 
        id = "13"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>To The Colors</name>
        <description>To The Colors</description>
    </key>
    <key 
        id = "14"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>CANCEL</name>
        <description>CANCEL</description>
    </key>
    <key 
        id = "15"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Alt Wail</name>
        <description>Alt Wail</description>
    </key>
    <key 
        id = "16"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>CANCEL</name>
        <description>CANCEL</description>
    </key>
    <key 
        id = "17"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Quiet Test</name>
        <description>Quiet Test</description>
    </key>
    <key 
        id = "18"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Reset</name>
        <description>Reset</description>
    </key>
</keys>
</giantVoiceSetting>

Note:   In this example, keys number 2, number 19, and number 20 could be used to add functions that are
available from the system but not programmed into the manual use SS2000D unit that the BlackBerry AtHoc-
integrated SS2000D Function Key section was created from.

For Integrations with Federal Signal SS2000+ encoders

This section describes how to program the SS2000+, integrate with the BlackBerry AtHoc IIM, and create the Key
User ATHOC-GV-KEYS attribute configuration.
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1. Follow the instructions in the Federal Signal Safety and Security Systems / Alert & Notification SS2000+
Manual, Document #255400C regarding the use of the Federal Signal SSLoader+ software and read the .INI file
from the SS2000+ and then save it to a local drive.

2. Flash the 1.8.1.30.HEX firmware version and the BlackBerry AtHoc.INI file with the SS2000+ to integrate with
the AtHoc IIM.

3. In the Comm Port Parameters section, in the General Configuration section, verify the following items:

• Com Port 1 Baud Rate—Set to either 9600 for communication with earlier versions of Federal Signal
Commander® software or 115200 for communication with newer versions.

• The Com Port 2 Baud Rate—Set for 9600.
• Com 2 Function—Set to Control.

4. On the Activation Functions tab, copy each of the Activation Functions number 1 through number 24 into
number 25 through number 48.

5. Add any RTU functions that are available in the system but not already programmed into buttons into
Activation Functions number 49 through number 60.

6. The Mode field of each Activation number 1 through number 24 should be configured as Auto Prompt Send.
7. The Mode field of each Activation number 25 through number 60 should be configured as Auto Send.

Additionally, the words BlackBerry AtHoc should be included in the Comment Sent to Printer field.
8. After the configuration is completed, save the .INI file with the name BlackBerry AtHoc to differentiate it from

the previously saved .INI file and then open the new file in the Notepad.
9. Scroll down to the Function Key section, Function Key 25.
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In the following example, Function Keys number 25 through number 46 are used.

FunctionKey25Name=Wail
FunctionKey25Encode1=FedDig.300.1.1.
FunctionKey25Encode2=
FunctionKey25Encode3=
FunctionKey25Mode=AutoSend 
FunctionKey25PrinterComment=AtHoc Wail Tone 
                    
FunctionKey26Name=Steady 
FunctionKey26Encode1=FedDig.300.2.1.
FunctionKey26Encode2=
FunctionKey26Encode3=
FunctionKey26Mode=AutoSend
FunctionKey26PrinterComment=AtHoc Steady Tone
                    
FunctionKey27Name=Severe Weather
FunctionKey27Encode1=FedDig.300.20.1.
FunctionKey27Encode2=
FunctionKey27Encode3=

FunctionKey27Mode=AutoSend
FunctionKey27PrinterComment=AtHoc Severe Weather
                    
FunctionKey28Name=AllClear
FunctionKey28Encode1=FedDig.300.21.1.
FunctionKey28Encode2=
FunctionKey28Encode3=
FunctionKey28Mode=AutoSend
FunctionKey28PrinterComment=AtHoc All Clear
                    
FunctionKey29Name=ActiveShooter
FunctionKey29Encode1=FedDig.300.22.1.
FunctionKey29Encode2=
FunctionKey29Encode3=
FunctionKey29Mode=AutoSend
FunctionKey29PrinterComment=AtHoc Active Shooter

FunctionKey30Name=Shelter InPlace
FunctionKey30Encode1=FedDig.300.23.1.
FunctionKey30Encode2=
FunctionKey30Encode3=
FunctionKey30Mode=AutoSend
FunctionKey30PrinterComment=AtHoc Shelter In Place
                    
FunctionKey31Name=Test Message
FunctionKey31Encode1=FedDig.300.27.1.
FunctionKey31Encode2=
FunctionKey31Encode3=
FunctionKey31Mode=AutoSend
FunctionKey31PrinterComment=AtHoc Test Message
                    
FunctionKey32Name=Taps
FunctionKey32Encode1=FedDig.300.12.1.
FunctionKey32Encode2=
FunctionKey32Encode3=
FunctionKey32Mode=AutoSend
FunctionKey32PrinterComment=AtHoc Taps
                    
FunctionKey33Name=Reveille
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FunctionKey33Encode1=FedDig.300.13.1.
FunctionKey33Encode2=
FunctionKey33Encode3=
FunctionKey33Mode=AutoSend
FunctionKey33PrinterComment=AtHoc Reveille

FunctionKey34Name=Colors
FunctionKey34Encode1=FedDig.300.14.1.
FunctionKey34Encode2=
FunctionKey34Encode3=
FunctionKey34Mode=AutoSend
FunctionKey34PrinterComment=AtHoc Colors
                    
FunctionKey35Name=Retreat
FunctionKey35Encode1=FedDig.300.15.1.
FunctionKey35Encode2=
FunctionKey35Encode3=
FunctionKey35Mode=AutoSend
FunctionKey35PrinterComment=AtHoc Retreat
                    
FunctionKey36Name=NationalAnthem
FunctionKey36Encode1=FedDig.300.16.1.
FunctionKey36Encode2=
FunctionKey36Encode3=
FunctionKey36Mode=AutoSend
FunctionKey36PrinterComment=AtHoc National Anthem
                    
FunctionKey37Name=Retreat & Nat.Anth.
FunctionKey37Encode1=FedDig.300.17.1.
FunctionKey37Encode2=
FunctionKey37Encode3=
FunctionKey37Mode=AutoSend
FunctionKey37PrinterComment=AtHoc Retreat & National Anthem
                    
FunctionKey38Name=Revelille & Colors
FunctionKey38Encode1=FedDig.300.18.1.
FunctionKey38Encode2=
FunctionKey38Encode3=
FunctionKey38Mode=AutoSend
FunctionKey38PrinterComment=AtHoc Reveille & To The Colors
                    
FunctionKey39Name=WestminsterChimes
FunctionKey39Encode1=FedDig.300.6.1.
FunctionKey39Encode2=
FunctionKey39Encode3=
FunctionKey39Mode=AutoSend
FunctionKey39PrinterComment=AtHoc Westminster

10.Copy the content into a Notepad and modify it to match the Function Keys. The XML maps to the Function Key
as shown in the previous example.

Note:  Key number 2, Public Address, is skipped as Public Address functions are handled as an RTU Function
through the All Poles, Pole, and Zone target user device address instead of a Function Key.

 

Note:  For Federal Signal Giant Voice Keys, the messageIdRef parameter is always MSG-TARGETING-NOT-
ALLOWED and the targetingRule parameter is always TargetingNotAllowed. This is because the targeting is set
in the SS2000+ Activation Functions and cannot be overridden.
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Note:  The key name and description parameters cannot contain spaces or any of the following
characters: ' ! $ % ^ ( ) = { } , ; : ? " &lt; &gt; |

<giantVoiceSetting> 
<messages> 
    <message id = "MSG-TARGETING-NOT-ALLOWED">The Giant Voice Key you have
 selected on the previous page does not allow
additional selection of Giant Voice poles or zones.  You may still target users
 for other devices, but Giant Voice targeting 
will be ignored.</message> 
    <message id = "MSG-TARGETING-ALLOWED">The Giant Voice Key you have selected on
 the previous page already has Giant
Voice poles and zones targeted, but you can override them by targeting different
 zones in the Targeting area just below.</message> 
    <message id = "MSG-TARGETING-REQUIRED">The Giant Voice Key you have selected
 on the previous page does not have 
any targeting information built-in, and will require you to target at least one
 Giant Voice pole or zone below.</message> 
</messages> 
<keys>
    <key 
        id = "25" 
        messageIdRef = "MSG-TARGETING-NOT- ALLOWED" 
        targetingRule = "TargetingNotAllowed"> 
        <name>Attack Warning - Wail Tone</name> 
        <description>Attack Warning - Wail Tone</description> 
    </key>
    <key 
        id = "26"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Disaster Warning - Steady Tone</name>
        <description>Disaster Warning - Steady Tone</description>
    </key>
    <key 
        id = "27"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Severe Weather</name>
        <description>Severe Weather</description>
    </key>
    <key
id = "28"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>All Clear</name>
        <description>All Clear</description>
    </key>
    <key 
        id = "29"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Active Shooter</name>
        <description>Active Shooter</description>
    </key>
    <key 
        id = "30"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Shelter In Place</name>
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        <description>Shelter In Place</description>
    </key>
    <key 
        id = "31"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Test Msg</name>
        <description>Test Msg</description>
    </key>
    <key 
        id = "32"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Taps</name>
        <description>Taps</description>
        </key>        
    <key 
        id = "33"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Reveille</name>
        <description>Reveille</description>
    </key>
    <key 
        id = "34"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>To The Colors</name>
     <description>To The Colors</description>
</key>
    <key 
        id = "35"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Retreat</name>
        <description>Retreat</description>
    </key>
    <key 
        id = "36"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>National Anthem</name>
        <description>National Anthem</description>
    </key>
    <key 
        id = "37"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Retreat and National Anthem</name>
        <description>Retreat and National Anthem</description>
    </key>
    <key 
        id = "38"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Reveille and To The Colors</name>
        <description>Reveille and To The Colors</description>
    </key>
    <key 
        id = "39"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
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        targetingRule = "TargetingNotAllowed">
        <name>Westminster Chimes</name>
        <description>Westminster Chimes</description>
    </key>
    <key 
        id = "40"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Quiet Test</name>
        <description>Quiet Test</description>
    </key>
    <key 
        id = "41"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Master Reset</name>
        <description>Master Reset</description>
    </key>
    <key 
        id = "42"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Cancel</name>
        <description>Cancel</description>
    </key>
    <key 
        id = "43"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Alternating Wail</name>
        <description>Alternating Wail</description>
    </key>
    <key 
        id = "44"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Alternating Steady</name>
        <description>Alternating Steady</description>
    </key>
    <key 
        id = "45"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Pulsed Wail</name>
        <description>Pulsed Wail</description>                
    </key>
    <key 
        id = "46"
        messageIdRef = "MSG-TARGETING-NOT-ALLOWED"
        targetingRule = "TargetingNotAllowed">
        <name>Pulsed Steady</name>
        <description>Pulsed Steady</description>    
    <key                    
</keys>
</giantVoiceSetting>

Create a key mass device endpoint

1. Log in to BlackBerry AtHoc management system as an administrator.
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2. In the navigation bar, click  .
3. In the Devices section, click Mass Device Endpoints.
4. Click New.
5. Select FedSig-Key-Menu from the list.
6. In the General section, in the Display Name field, enter a name that describes the function of the associated

call key, so that it is easy to identify which key is for which function.
7. In the Configuration section, select Key for Giant Voice Type
8. Copy the Key XML configuration into the Giant Voice Key field
9. In the Address field, enter K.
10.Click Save.

Create and publish a Federal Signal Giant Voice alert template
Prerequisites

• Before you start sending test alerts through Federal Signal Giant Voice, consider the impact it has on everyone
within hearing distance of the poles you are using during the test.

• This process assumes that the IIM is not configured to download data from the BlackBerry AtHoc
management server and is not connected to the Giant Voice equipment.

• Consult with your POC as to the acceptable content of the test alert. For example, the word "test" should
appear at, or very near to, the start of the broadcast message.

• Although the initial use of this template is to test the data creation process, this template can be used during
the audio tuning phase after the IIM and Giant Voice hardware are connected.

To confirm that the Federal Signal Giant Voice device is installed correctly on the BlackBerry AtHoc management
system, create a template.

1. Log in to the BlackBerry AtHoc management system as an administrator.
2. In the top navigation bar, click Alerts > Alert Templates.
3. Click New.
4. On the New Template page, in the Alert Template section, enter a template name and description.
5. Select a folder from the Folder list.
6. Select Available for Quick Publish.
7. In the Content section, enter the title and content of the alert.
8. In the Mass Devices section, select Federal Signal Giant Voice.
9. Select one or more mass alert endpoints from the pull-down list.
10.On the top right corner of the Mass Devices section, click Options.
11.On the Mass Devices Options page, select the Text to Speech.
12.Select Alert Body or Custom Text.
13.Click Apply.
14.In the Schedule section, change the Alert Duration to 15 minutes.
15.Click Preview and Save.
16.On the preview page, click Save.
17.Click  to go to the Home page.
18.In the Quick Publish section, find the alert template you created.
19.Click Publish.
20.On the Review and Publish screen, review the settings and selections.
21.Click Publish.
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Verify the published alert

To verify that the alert was published successfully to the syndication feed, complete the following steps:

1. Open a browser and navigate to the following URL: https://<url>/syndication/cap_fedsig_<vps-
id>/capindex.

Where <url> is the base URL of the BlackBerry AtHoc management system (for example, https://
integration7.athoc.com) and <vps-id> is the 7 or 8-digit Org ID.

2. Copy the content in the <url> field into another browser. The “capIndex” XML format must be similar to the
content in the following image:

3. Verify the <addresses> and <code> to match with the following format. The “alert” XML format must be similar
to the content in the following image:

4. If any of the formatting does not match, review the Federal Signal Giant Voice Gateway XML content and Mass
Communication Users’ Federal Signal Giant Voice device addressing. Errors in these sections are the most
common reason for malformed Alert XML fields.
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Test pre-installation legacy functionality
Before making any modifications to the Federal Signal hardware programming or wiring, ensure that the legacy
functions are operational. Any pre-existing problems that were not identified during testing before making
changes to wiring or programming configuration could make troubleshooting more difficult after full system
testing begins.

If the site has SS2000D, SS2000+ or the Commander® software, have the customer or site operations POC initiate
a Quiet Test and Health Feedback function of the poles and observe the health statuses of each pole on the
SS2000D, SS2000+ or the Commander® software.

In addition, the site should initiate a Public Address function and make a manual microphone announcement.
The microphone announcement should be observed as providing a loud and clear signal from an unobstructed
listening position 100–200 yards from a Giant Voice pole, preferably in line-of-site with the pole and not near any
buildings or large structures.

Record any displayed faults or lack of clarity of any broadcasts observed. It may only be possible to create audio
with the new integration on par with the legacy audio functionality.
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Configure IIM IP connectivity
This section describes the steps to configure the IP Integration Module (IIM) to communicate with the BlackBerry
AtHoc Federal Signal device.

Prerequisite

Ensure that the following packages are installed and configured before performing any tasks:

• Latest Federal Signal BlackBerry AtHoc device package
• Latest Federal Signal IIM Capnode package
• Latest IIM Agent

To work as part of the BlackBerry AtHoc system, IIM must be able to communicate with the BlackBerry AtHoc
server to download the CAP packets.

The initial configuration data you need to collect are:

• The BlackBerry AtHoc Alerts system base URL
• The BlackBerry AtHoc Alerts Organization ID
• Customer’s proxy server and port information

To find this information, use a local PC to log in to your local instance of the BlackBerry AtHoc management
console. The URL can be a base “https” address used to access a specific system. You can obtain the URL of
the system from the local system administrator or from the Blackberry Customer support team. Launch the
management console. The URL from the “https” to the last character before the third forward slash (/) is the “base
URL” of the system. For example, in the following URL address bar, the full URL for the sign-on page is: https://
integration7.athoc.com/client/auth/login?ReturnUrl=%2fclient%2fathoc-iws. The “base-URL” of the system is
https://integration7.athoc.com.

The organization ID is a 7 or 8-digit numerical identifier of the specific system of that customer. To obtain this
Organization ID, log in to the BlackBerry AtHoc management system for the customer. Once logged in, you can
find the system’s organization ID at the top right of the Home Page of the system.

Navigate to the settings page of the browser and determine if you are using any type of Proxy server for routing
internet traffic. For example, if the browser you are using is Microsoft Internet Explorer (IE), go to the LAN
settings, in IE, select Tools > Internet Options. On the Internet Options screen, click the Connections tab. At the
bottom of the window, click LAN settings.

In the Proxy Server section, click Advanced. The Proxy Settings screen displays the Proxy Server Address.

Record the proxy server address and the port number. You can now close these settings windows and exit IE.

Note:  It is also possible that your IE instance may not use proxy servers. If this is the case, when you click the
LAN settings button, no proxy server is used for internet traffic on this network.

Configure the system_private.config file
1. Open Microsoft Notepad as an administrator.
2. Click File > Open.
3. Navigate to C:\Program Files\capnode and change the file selection from “Text Documents (*.txt)” to “All

Files (*.*)”.
4. Select the system_private file.
5. Click Open.
6. Verify the following items in the system_private.config file:
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a. The indexURL variable should be formatted similar to the following image. The base URL should be
followed by “/syndication/”, then the device gateway protocol ID (for example, CAP_FedSig for an Federal
Signal Giant Voice system), the Organization ID number, followed by "/capindex".

b. The “#” at the beginning of a line in the system_private.config file is used to comment out an unused
line. The “#” should be removed from a line to use the variable.

7. Enter the proxy server and proxy port information you collected earlier in the proxyServer and proxyPort
parameters. If the settings on the machine that you tested with is set for “Automatic” in the proxy settings, the
settings for those two lines displays as follows:

• proxyServer=none
• proxyPort=8080

8. Update the CapPostingTarget variables to reflect the correct URL using the same base URL as in
the indexURL variable.

9. If the integration uses a Federal Signal SS2000D encoder, the following AckMode variable should be set to
false. Otherwise, it should be set to true. encoder.SirenCentralDriverFS.SingleAckMode=false

10.The Federal Signal COM Port settings displayed in the following images are default values and should not be
changed.

11.Click File > Save.
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12.Close the system_private.config file.
13.Restart the CapCon service.

Restart the CapCon service
1. Navigate to your IIM system.
2. Go to Start > Run > Services.
3. Launch an instance of the Services Manager application. There should be a quick-launch icon in the taskbar of

the desktop.
4. Scroll down to the IIM CapCon Service.
5. Right-click the CapCon Services row and select  restart or stop.
6. Start the CapCon Service.

Verify the CapCon system activity console (GUI)
1. Log in to the IIM console as an administrator. The CapCon Console loads automatically.

The data in the CapCon System Activity console polls at the rate set by the delayBetweenRXpolls variable
in the system_private.config file. The default is set to 7 seconds. A message indicates the total number
of items in the index. The index number is the number of active alerts on the BlackBerry AtHoc system at that
time.

2. Verify that the IIM console does not show any new errors.

3. Verify that the console icon in the task tray appears green, indicating that the connectivity between the IIM and
the BlackBerry AtHoc Alerts system is good.
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Troubleshooting
If the CapCon System Activity console indicates anything other than a total number of items in the index and a
number, or if the CapCon System Errors/Exceptions/Warnings console has content in red, this indicates that the
configuration has not been executed correctly.

To troubleshoot the configuration, complete the following steps:

1. If the BlackBerry AtHoc management system, for example, https://integration4.athoc.com/client/
default.asp">https://integration7.athoc.com/athoc-iws is available on IE on a local workstation, then
the indexURL should also be available. Enter the indexURL in the browser. For example,  https://
integration4.athoc.com/syndication/cap_whelen_v2/2060520/capindex">https://integration7.athoc.com/
syndication/cap_fedsig/2086867/capindex.

If there are no items in the syndication feed, an XML similar to the following image should be displayed:

If there are items in the feed, an XML similar to the following image should be displayed:

2. If connectivity is still not good, try commenting out the proxyServer and proxyPort variables.
3. If an HTTP or HTTPS error is displayed instead of XML, this may indicate a firewall or certificate issue or a

configuration problem with the BlackBerry AtHoc server syndication folder or subfolders.
4. Check the indexURL and proxy settings in the system_private.config file for any misspellings. If any line

have been misspelled, repeat the configuration steps.
5. Check the capnodelog file for errors. Open Windows Explorer by right-clicking on the IIM Start button and

navigate to C:/Program Files/capnode/capnodelogs and open the capnode.log file with Notepad.
Browse the file to find the time that the indexURL was changed and the CapCon service restarted.
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6. Contact BlackBerry AtHoc technical support. Be prepared to provide
the system_private.config and capnode.log files and screen shots of the console screen and the
BlackBerry AtHoc management console pages.
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Test Post-installation final legacy functionality 
Once the wiring modifications needed to complete the integration are complete, the integrator must ensure that
the legacy functions of the original system are still operational.

Note:  For instructions about the wiring modifications, contact the BlackBerry AtHoc Customer Support team and
request a copy of the BlackBerry AtHoc IIM Central Control Unit Interconnection Guide.

This is essentially the same test that was performed before the modifications were made. This test must be
performed again to ensure that any changes that were made have not created any problems with the legacy
system’s operation.

If the site has SS2000D, SS2000+ or the Commander® software, have the customer or site operations POC initiate
a Quiet Test and Health Feedback function of the poles and observe the health statuses of each pole on the
SS2000D or SS2000+ LCD or the Commander® software.

The site should initiate a Public Address function and make a manual microphone announcement. The
microphone announcement should be observed as providing a loud and clear signal from an unobstructed
listening position 100–200 yards from a Giant Voice pole, preferably in line-of-site with the pole, and not near any
buildings or large structures.

Record any changes in operation since the pre-installation legacy functionality testing stage. If functionality does
not work as expected, review the work that was performed and verify that all wiring has been terminated.
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Test and verification
The following sections describe how to create and publish a pre-test alert template, verify the serial
communication, and adjust audio settings.

Create and publish a pre-test alert template
Prerequisite

• Before you start sending test alerts through Federal Signal Giant Voice, consider the impact on everyone within
hearing distance of the poles you are using during the test.

• Consult with your POC as to the acceptable content, user targeting, and device selection of the pre-test
notification.

To create a template that targets end users using desktop pop-up, email, and messages to other devices to inform
them of a Giant Voice System test, complete the following steps:

1. Log in to the BlackBerry AtHoc management system as an administrator.
2. In the top navigation bar, click Alerts > Alert Templates.
3. On the Alert Templates page, click New.
4. On the New Template page, in the Alert Template section, enter a template name and description.
5. Select a folder from the Folder list. Select Test if available.
6. Select Available for Quick Publish.
7. Select Informational from the Severity list.
8. Select Other from the Type list.
9. In the Content section, enter an alert title. The alert title can be the same as the template name.
10.In the Body field, enter the text to be read by the text-to-speech. The body should contain the details of the

testing with information such as the time testing will start and finish and any actions that should be taken as a
result.

11.In the Target Users section, select the appropriate targeting group, individual users, or query to send the pre-
test notification to.

12.Click Select Personal Devices.
13.Select Desktop App and Email-Personal.
14.In the top right corner of the Personal Devices section, click Options.
15.On the Personal Devices Options screen, click the Desktop Popup tab.
16.Select App Template and App Audio options.
17.Click Apply.
18.In the Schedule section, change the Alert Duration to the expected duration of the testing.
19.Click Preview and Save.
20.On the preview page, click Save.
21.Click  to go to the Home page.
22.In the Quick Publish section, find the template you created.
23.Click Publish.
24.On the Review and Publish page, review the settings and selections.
25.Click Publish.
26.To verify that the alert was published correctly, observe the receipt of desktop pop-up or email messages on

the POC workstation.
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Verify the serial communication
If the system has been configured with a Key User containing Cancel All or Quiet Test commands, these keys can
be used to test the serial interconnection without generating any sound through the Giant Voice System.

1. Log in to the BlackBerry AtHoc management system as an administrator.
2. On the Home page, in the Quick Publish section, search for Giant Voice System Test and then click Edit.
3. In the Mass Devices section, select Federal Signal Giant Voice.
4. Select one or more mass alert endpoints from the pull-down list.
5. In the top right corner of the Mass Devices section, click Options.
6. On the Mass Devices Options screen, select Giant Voice Key.
7. From the list, select CANCEL or Quiet Test.

Note:  Keys use implicit targeting. For example, the targeting is built into the SS2000+, SS200D Activation
Function or the Federal Signal Commander® software Hot Keys, and targeting is not allowed when using
Federal Signal Giant Voice Keys.

8. Click Apply.
9. In the Schedule section, change the Alert Duration to 15 minutes.
10.Click Review and Publish.
11.On the Review and Publish page, review the settings and selections.
12.Click Publish.
13.Observe the operations of the following:

• In the IIM console window: the number of items in index increases and it starts processing the alert.
• The SS2000+, SS2000D, or Commander® software transmits the Activation Function or Hot Key selected in

the BlackBerry AtHoc management system.
• Associated Giant Voice poles emits no sound because of the command sent.

14.If unexpected results are found, do the following:

a. Double-check the SS2000+ or SS2000D Activation Function programming or the Commander® software
Hot Key configuration.

b. Verify that the Key User ATHOC-GV-KEYS attribute configuration file is constructed correctly.
15.If activation fails, double-check the serial cable connections, IIM Com Port settings, and

system_private.config file serial configuration variables.

WAV file audio level adjustments
IIM pre-recorded audio and text-to-speech audio tuning audio calibration must be performed in steps to calibrate
the individual audio levels for pre-recorded audio (WAV file) play and text-to-speech. Some adjustments can be
made by ear but can be more accurate if diagnostic tools are used. For radio-based systems, if a radio meter with
an FM deviation scale can be used, the accuracy of the tuning can be more precise. For non-radio-based systems,
a digital voltage meter can be used to read the levels of the transmitted audio.

Depending on the integration type, there can be different variables in the system_private.config file that
need to be tuned. For Federal Signal, the variables that typically require tuning are related to time delays, variables
with “before” or “after”, and text-to-speech attributes variables with “TTS”.

1. Adjust the IIM Windows Audio Tool Tray Slider to approximately 25% as a starting point.

The Giant Voice System Test template should be edited to use pre-recorded audio content; typically the “Test
GVS” file. Observe the audio level and clarity in comparison with the manual activation baseline.

2. Log in to the BlackBerry AtHoc management system as an administrator.
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3. In the Quick Publish section, search for the Giant Voice System Test template.
4. Click Edit.
5. In the Mass Devices section, select Federal Signal Giant Voice.
6. In the top right corner of the Mass Devices section, click Options.
7. On the Mass Devices Options screen, select Pre-recorded Audio.
8. From the list, select Test GVS.
9. Click Apply.
10.Click Review and Publish.
11.On the Review and Publish page, review the settings and selections.
12.Click Publish.
13.Observe the operations of the following:

• In the IIM console window, the number of items in index increases and that it starts processing the alert.
• The SS2000+, SS2000D, or Commander® software transmits the Public Address RTU Function.
• The associated Giant Voice poles and the audio volume and clarity.

14.Adjust the IIM Windows Audio Tool Tray Slider to match the baseline audio level and clarity.
15.Repeat steps 2 to 13 until the pre-recorded audio sounds close in volume and clarity to manual microphone

announcements.

Text-to-speech audio level and characteristic adjustments
The previously configured Giant Voice System Test template should have been configured to use POC-approved
verbiage and text-to-speech. Observe the audio level and clarity in comparison with the manual activation baseline
and make adjustments as required.

1. Log in to the BlackBerry AtHoc management system as an administrator.
2. On the Home page, in the Quick Publish section, search for Giant Voice System Test.
3. Click Edit.
4. Click Review and Publish.
5. On the Review and Publish page, review the settings and selections.
6. Click Publish.
7. Observe the operations of the following:

• In the IIM console window, the number of items in index increases and that it starts processing the alert.
• The SS2000+, SS2000D, or Federal Signal Commander® software transmits the Public Address RTU

Function.
• The associated Giant Voice poles and the audio volume and clarity.

8. Using Microsoft Notepad, open the system_private.config file located at C:\Program Files
\capnode\system_private.config.

9. In the Notepad, find the following:

• encoder.SirenCentralEncoder.TTS_Volume variable and adjust up or down to match the baseline
audio level.

• encoder.SirenCentralEncoder.TTS_Speed variable and adjust up or down to adjust the rate of
speech. The speed variable is in words per minute.

• encoder.SirenCentralEncoder.TTS_Pitch and encoder.SirenCentralEncoder.TTS_Range
variables and adjust up or down to adjust the pitch and inflection of the speaking voice.

10.Click File > Save.
11.Using the Service Manager, restart the CapCon Services.
12.Run another test and observe the audio characteristics.
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13.Repeat steps 2 to 12 until the prerecorded audio sounds close in volume and the clarity to the baseline.

Function sequencing adjustments
The previously configured Giant Voice System Test template should have been configured to use POC-approved
verbiage and text-to-speech. Observe the timing of the IIM, SS2000D, SS2000+ encoder, or Federal Signal
Commander® software. If the audio is being clipped at the beginning or end, or if there is a long delay before or
after the audio, make adjustments to variables in the system_private.config file to adjust the sequencing.

1. Log in to the BlackBerry AtHoc management system as an administrator.
2. On the Home page, in the Quick Publish section, search for Giant Voice System Test.
3. Click Edit.
4. Click Review and Publish.
5. On the Review and Publish page, review the settings and selections.
6. Click Publish.
7. Observe the operations of the following items:

• In the IIM console window, the number of items in index increases and that it starts processing the alert.
• The SS2000+, SS2000D, or Federal Signal Commander® software transmits the Public Address RTU

Function.
• The associated Giant Voice poles and the audio volume and clarity.

Note:  The typical sequence of IIM operation when receiving alerts with text-to-speech content is for the
poles to turn on the Public Address (PA) mode, transmit the TTS content and then turn off when a Cancel
command is received. The siren poles also turn off after 7 to 10 seconds without receiving a command or
audio content on air. In many cases, the Cancel command can be delayed after the audio by approximately
13 seconds and the sirens turn off before receiving the Cancel command, with the command reserved for
canceling in poor conditions. However, in systems with noisy RF conditions, the Cancel command should
be sent immediately after the audio content so that squelch noise and other on-air transmissions stop the
broadcast.

8. Using the Microsoft Notepad, navigate to C:\Program Files\capnode\system_private.config and open the
system_private.config file.

9. In the Notepad file, find the following items:
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• encoder.SirenCentralEncoder.SirenCentralDriverWhelen.Delay_for_PAcode_TX variable
and adjust up or down to increase or decrease the delay between sending the content of the external call
key and beginning to turn on the relays. The default is 5000 ms.

• encoder.SirenCentralEncoder.ptt_before variable and adjust the delay between the relays
turning on and the beginning of the audio content. The default is 100 ms between R1 turning on and R3
turning on; 100 ms between R3 turning on and R4 turning on; and 1000 ms between R4 turning on and the
audio beginning to play.

• encoder.SirenCentralEncoder.ptt_after variable and adjust the delay between the audio content
finishing and the relays turning off. The default is 100 ms between audio finish and R4 turning off; 100 ms
between R4 turning off and R3 turning off; and 1000 ms between R3 turning off and R1 turning off.

10.Click File > Save.
11.Close the Notepad file.
12.Using the Service Manager, restart the CapCon services.
13.Run another test and observe the audio characteristics.
14.Repeat steps 2 to 13 until the prerecorded audio sounds close in volume and the clarity to the baseline.
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BlackBerry AtHoc Customer Support Portal
BlackBerry AtHoc customers can obtain more information about BlackBerry AtHoc products or get answers to
questions about their BlackBerry AtHoc systems through the Customer Support Portal:

https://www.blackberry.com/us/en/support/enterpriseapps/athoc

The BlackBerry AtHoc Customer Support Portal also provides support via computer-based training, operator
checklists, best practice resources, reference manuals, and user guides.
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Documentation feedback
The BlackBerry AtHoc documentation team strives to provide accurate, useful, and up-to-date technical
documentation. If you have any feedback or comments about BlackBerry AtHoc documentation, email
athocdocfeedback@blackberry.com. Please include the name and version number of the document in your email.

To view additional BlackBerry AtHoc documentation, visit https://docs.blackberry.com/en/id-comm-collab/
blackberry-athoc. To view the BlackBerry AtHoc Quick Action Guides, see https://docs.blackberry.com/en/id-
comm-collab/blackberry-athoc/Quick-action-guides/latest.

For more information about BlackBerry AtHoc products or if you need answers to questions about your BlackBerry
AtHoc system, visit the Customer Support Portal at https://www.blackberry.com/us/en/support/enterpriseapps/
athoc.
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and without condition, endorsement, guarantee, representation, or warranty of any kind by BlackBerry Limited and
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technology in generalized terms. BlackBerry reserves the right to periodically change information that is contained
in this documentation; however, BlackBerry makes no commitment to provide any such changes, updates,
enhancements, or other additions to this documentation to you in a timely manner or at all.
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SERVICES, DOWNTIME COSTS, LOSS OF THE USE OF BLACKBERRY PRODUCTS OR SERVICES OR ANY PORTION
THEREOF OR OF ANY AIRTIME SERVICES, COST OF SUBSTITUTE GOODS, COSTS OF COVER, FACILITIES OR
SERVICES, COST OF CAPITAL, OR OTHER SIMILAR PECUNIARY LOSSES, WHETHER OR NOT SUCH DAMAGES
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WERE FORESEEN OR UNFORESEEN, AND EVEN IF BLACKBERRY HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, BLACKBERRY SHALL
HAVE NO OTHER OBLIGATION, DUTY, OR LIABILITY WHATSOEVER IN CONTRACT, TORT, OR OTHERWISE TO
YOU INCLUDING ANY LIABILITY FOR NEGLIGENCE OR STRICT LIABILITY.

THE LIMITATIONS, EXCLUSIONS, AND DISCLAIMERS HEREIN SHALL APPLY: (A) IRRESPECTIVE OF THE NATURE
OF THE CAUSE OF ACTION, DEMAND, OR ACTION BY YOU INCLUDING BUT NOT LIMITED TO BREACH OF
CONTRACT, NEGLIGENCE, TORT, STRICT LIABILITY OR ANY OTHER LEGAL THEORY AND SHALL SURVIVE A
FUNDAMENTAL BREACH OR BREACHES OR THE FAILURE OF THE ESSENTIAL PURPOSE OF THIS AGREEMENT
OR OF ANY REMEDY CONTAINED HEREIN; AND (B) TO BLACKBERRY AND ITS AFFILIATED COMPANIES, THEIR
SUCCESSORS, ASSIGNS, AGENTS, SUPPLIERS (INCLUDING AIRTIME SERVICE PROVIDERS), AUTHORIZED
BLACKBERRY DISTRIBUTORS (ALSO INCLUDING AIRTIME SERVICE PROVIDERS) AND THEIR RESPECTIVE
DIRECTORS, EMPLOYEES, AND INDEPENDENT CONTRACTORS.

IN ADDITION TO THE LIMITATIONS AND EXCLUSIONS SET OUT ABOVE, IN NO EVENT SHALL ANY DIRECTOR,
EMPLOYEE, AGENT, DISTRIBUTOR, SUPPLIER, INDEPENDENT CONTRACTOR OF BLACKBERRY OR ANY
AFFILIATES OF BLACKBERRY HAVE ANY LIABILITY ARISING FROM OR RELATED TO THE DOCUMENTATION.

Prior to subscribing for, installing, or using any Third Party Products and Services, it is your responsibility to
ensure that your airtime service provider has agreed to support all of their features. Some airtime service
providers might not offer Internet browsing functionality with a subscription to the BlackBerry® Internet Service.
Check with your service provider for availability, roaming arrangements, service plans and features. Installation
or use of Third Party Products and Services with BlackBerry's products and services may require one or more
patent, trademark, copyright, or other licenses in order to avoid infringement or violation of third party rights. You
are solely responsible for determining whether to use Third Party Products and Services and if any third party
licenses are required to do so. If required you are responsible for acquiring them. You should not install or use
Third Party Products and Services until all necessary licenses have been acquired. Any Third Party Products and
Services that are provided with BlackBerry's products and services are provided as a convenience to you and are
provided "AS IS" with no express or implied conditions, endorsements, guarantees, representations, or warranties
of any kind by BlackBerry and BlackBerry assumes no liability whatsoever, in relation thereto. Your use of Third
Party Products and Services shall be governed by and subject to you agreeing to the terms of separate licenses
and other agreements applicable thereto with third parties, except to the extent expressly covered by a license or
other agreement with BlackBerry.

The terms of use of any BlackBerry product or service are set out in a separate license or other agreement with
BlackBerry applicable thereto. NOTHING IN THIS DOCUMENTATION IS INTENDED TO SUPERSEDE ANY EXPRESS
WRITTEN AGREEMENTS OR WARRANTIES PROVIDED BY BLACKBERRY FOR PORTIONS OF ANY BLACKBERRY
PRODUCT OR SERVICE OTHER THAN THIS DOCUMENTATION.

BlackBerry Enterprise Software incorporates certain third-party software. The license and copyright information
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